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Preface

This publication is for the customer who will be installing and or operating the Virtual 
Operator Panel (VOP). 

Organization
The organization of this guide is:  

Chapter 1 “Installation” provides information regarding the installation of the Virtual 
Operator Panel software. 

Chapter 2 “Single Drive Operation” describes the operation of the virtual operator 
panel. 

Appendix A “Computer Path Additions for Windows 2000 and XP” describes the 
modification of the search path on a computer operating Windows 2000 or 
XP. 

Appendix B “VOP in Multiple Drive Installations” gives instructions for configuring 
drives in the multi-drive environment with the VOP.

Appendix C “Service Calls” gives information regarding placing service calls in order to 
minimize the tape drive’s down time.

Glossary The “Glossary” defines some terms and abbreviations used in this guide. 

Index The “Index” provides an additional means of locating information within this 
document. 
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Additional Information
This section offers several methods to obtain additional information. 

Sun’s External Web Site
Sun’s external Web site provides marketing, product, event, corporate, and service 
information. The external Web site is accessible to anyone with a Web browser and an 
Internet connection.

The URL for the  external Web site is: http://www.sun.com

The URL for StorageTek™ brand-specific information is: 
http://www.storagetek.com

Sun Microsystems StorageTek Support Center
The Sun Microsystem’s StorageTek Support Center is a Web site that enables members 
to resolve technical issues by searching code fixes and technical documentation for 
StorageTek brand products. Support center membership entitles you to other proactive 
services, such as HIPER subscriptions, technical tips, answers to frequently asked 
questions, addenda to product documentation books, and online product support 
contact information. Customers who have a current warranty or a current maintenance 
service agreement may apply for membership by clicking on the Request Password 
button on the Customer Resource Center (CRC) home page. 

The URL for the CRC is http://www.support.storagetek.com 

Customer-Initiated Maintenance
Customer-initiated maintenance begins with a telephone call from you to Sun 
Microsystems StorageTek Support. You receive immediate attention from qualified  
personnel, who record problem information and respond with the appropriate level of 
support.

To contact  Microsystems StorageTek Support about a problem, use the telephone and 
call:

 800.525.0369 (inside the United States)

 303.673.4056 (outside the United States)

Sun Partners Site
The StorageTek Partners site is a Web site for partners with a StorageTek Partner 
Agreement. This site provides information about products, services, customer support, 
upcoming events, training programs, and sales tools to support StorageTek Partners. 

http://www.sun.com
http://www.storagetek.com
http://www.support.storagetek.com
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Access to this site, beyond the Partners Login page, is restricted. On the Partners Login 
page,  employees and current partners who do not have access can request a login ID 
and password and prospective partners can apply to become StorageTek resellers.

The URL for the StorageTek Partners site is: 
http://members.storagetek.com 

The URL for partners with a Sun Partner Agreement is:  
http://www.sun.com/partners/

http://members.storagetek.com
http://www.sun.com/partners/
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Internal Code License Statement
The following is the Internal Code License Agreement from StorageTek:

The following is the Internal Code License Agreement from StorageTek:
NOTICE

INTERNAL CODE LICENSE
PLEASE READ THIS NOTICE CAREFULLY BEFORE INSTALLING AND OPERATING THIS EQUIPMENT. THIS 
NOTICE IS A LEGAL AGREEMENT BETWEEN YOU (EITHER AN INDIVIDUAL OR ENTITY), THE END USER, 
AND STORAGE TECHNOLOGY CORPORATION (“STORAGETEK”), THE MANUFACTURER OF THE 
EQUIPMENT. BY OPENING THE PACKAGE AND ACCEPTING AND USING ANY UNIT OF EQUIPMENT 
DESCRIBED IN THIS DOCUMENT, YOU AGREE TO BECOME BOUND BY THE TERMS OF THIS AGREEMENT. 
IF YOU DO NOT AGREE WITH THE TERMS OF THIS AGREEMENT, DO NOT OPEN THE PACKAGE AND USE 
THE EQUIPMENT. IF YOU DO NOT HAVE THE AUTHORITY TO BIND YOUR COMPANY, DO NOT OPEN THE 
PACKAGE AND USE THE EQUIPMENT. IF YOU HAVE ANY QUESTIONS, CONTACT THE AUTHORIZED 
STORAGETEK DISTRIBUTOR OR RESELLER FROM WHOM YOU ACQUIRED THIS EQUIPMENT. IF THE 
EQUIPMENT WAS OBTAINED BY YOU DIRECTLY FROM STORAGETEK, CONTACT YOUR STORAGETEK 
REPRESENTATIVE. 

1. Definitions: The following terms are defined as 
follows:
a. “Derivative works” are defined as works based 

upon one or more preexisting works, such as a 
translation or a musical arrangement, or any other 
form in which a work may be recast, transformed, 
or adapted. A work consisting of editorial revision, 
annotations, elaboration, or other modifications 
which, as a whole, represent an original work of 
authorship, is a Derivative work.

b. “Internal Code” is Microcode that (i) is an integral 
part of Equipment, (ii) is required by such 
Equipment to perform its data storage and retrieval 
functions, and (iii) executes below the user interface 
of such Equipment. Internal code does not include 
other Microcode or software, including data files, 
which may reside or execute in or be used by or in 
connection with such Equipment, including, 
without limitation, Maintenance Code.

c. “Maintenance Code” is defined as Microcode and 
other software, including data files, which may 
reside or execute in or be used by or in connection 
with Equipment, and which detects, records, 
displays, and/or analyzes malfunctions in the 
Equipment.

d. “Microcode” is defined as a set of instructions 
(software) that is either imbedded into or is to be 
loaded into the Equipment and executes below the 
external user interface of such Equipment. 
Microcode includes both Internal Code and 
Maintenance Code, and may be in magnetic or other 
storage media, integrated circuitry, or other media.

2. The Equipment you have acquired by purchase or 
lease is manufactured by or for StorageTek and 
contains Microcode. By accepting and operating this 
Equipment, you acknowledge that StorageTek or its 

licensor(s) retain(s) ownership of all Microcode, 
as well as all copies thereof, that may execute in 
or be used in the operation or servicing of the 
Equipment and that such Microcode is 
copyrighted by StorageTek or its licensor(s).

3. StorageTek hereby grants you, the end user of the 
Equipment, a personal, nontransferable (except as 
permitted in the transfer terms below), nonexclusive 
license to use each copy of the Internal Code (or any 
replacement provided by StorageTek or your 
authorized StorageTek distributor or reseller) which 
license authorizes you, the end user, to execute the 
Internal Code solely to enable the specific unit of 
Equipment for which the copy of Internal Code is 
provided to perform its data storage and retrieval 
functions in accordance with StorageTek’s (or its 
licensor’s) official published specifications.

4. Your license is limited to the use of the Internal Code 
as set forth. You may not use the Internal Code for any 
other purpose. You may not, for example, do any of 
the following:

(i) access, copy, display, print, adapt, alter, 
modify, patch, prepare Derivative works of, 
transfer, or distribute (electronically or 
otherwise) or otherwise use the Internal Code;
(ii) reverse assemble, decode, translate, 
decompile, or otherwise reverse engineer the 
Internal Code (except as decompilation may be 
expressly permitted under applicable European 
law solely for the purpose of gaining 
information that will allow interoperability 
when such information is not otherwise readily 
available); or
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(iii) sublicense, assign, or lease the Internal Code 
or permit another person to use such Internal 
Code, or any copy of it.

5. Nothing in the license set forth above or in this entire 
Notice shall convey, in any manner, to you any license 
to or title to or other right to use any Maintenance 
code, or any copy of such Maintenance Code. 
Maintenance Code and StorageTek’s service tools and 
manuals may be kept at your premises, or they may 
be supplied with a unit of Equipment sent to you 
and/or included on the same media as Internal Code, 
but they are to be used only by StorageTek’s customer 
service personnel or those of an entity licensed by 
StorageTek, all rights in and to such Maintenance 
Code, service tools and manuals being reserved by 
StorageTek or its licensors. You agree that you shall 
not use or attempt to use the Maintenance Code or 
permit any other third party to use and access such 
Maintenance Code.

6. You, the end user, agree to take all appropriate steps 
to ensure that all of your obligations set forth in this 
Notice are extended to any third party having access 
to the Equipment.

7. You may transfer possession of the Internal Code to 
another party only with the transfer of the Equipment 
on which its use is authorized, and your license to use 
the Internal Code is discontinued when you are no 
longer an owner or a rightful possessor of the 
Equipment. You must give such transferee all copies 
of the Internal Code for the transferred Equipment 
that are in your possession, along with a copy of all 
provisions of this Notice.

Any such transfer by you is automatically 
(without further action on the part of either 
party) expressly subject to all the terms and 
conditions of this Notice passing in full to the 
party to whom such Equipment is transferred, 
and such transferee accepts the provisions of this 
license by initial use of the Internal Code. You 
cannot pass to the transferee of the Equipment 
any greater rights than granted under this 
Notice, and shall hold StorageTek harmless from 
any claim to the contrary by your transferee or 
its successors or assigns. In addition, the terms 
and conditions of this Notice apply to any copies 
of Internal Code now in your possession or use 
or which you hereafter acquire from either 
StorageTek or another party.

8. You acknowledge that copies of both Internal Code 
and Maintenance Code may be installed on the 
Equipment before shipment or included with the 
Equipment and other material shipped to you, all for 
the convenience of StorageTek’s service personnel or 
service providers licensed by StorageTek, and that 
during the warranty period, if any, associated with the 
Equipment, and during periods in which the 
Equipment is covered under a maintenance contract 
with StorageTek or service providers licensed by 
StorageTek, both Internal Code and Maintenance Code 
may reside and be executed in or used in connection 
with such Equipment, and you agree that no rights to 
Maintenance Code are conferred upon you by such 
facts. 

StorageTek or the licensed service provider may 
keep Maintenance Code and service tools and 
manuals on your premises but they are to be 
used only by StorageTek’s customer service 
personnel or those of service providers licensed 
by StorageTek. You further agree that upon  
(i) any termination of such warranty period or 
maintenance contract period; or  
(ii) transfer of possession of the Equipment to 
another party, StorageTek and its authorized 
service providers shall have the right with 
respect to the affected Equipment to remove all 
service tools and manuals and to remove or 
disable all Maintenance Code and/or replace 
Microcode which includes both Internal Code 
and Maintenance Code with Microcode that 
consists only of Internal Code.
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CHAPTER

 

1

Installation

This chapter is about the installation of the Virtual Operator Panel (VOP), its associated 
software, and changes to existing software settings. 

Computer Hardware Requirements
These are the hardware requirements for this Virtual Operator Panel installation:

■ 512 megabytes memory 

■ 1000 megahertz processor 

Note – For best results set the monitor screen resolution to 1024 x 768 or greater.

■ Available Ethernet port on the computer or set up a private network with a second 
Ethernet card as discussed in Appendix B, “VOP in Multiple Drive Installations”. 

■ RJ45-RJ45 Ethernet cross-over cable (length as required, this connects the computer 
to a single T10000 tape drive) 

Note – When a Service Delivery Platform (SDP) is installed at a customer site, the SDP 
is connected to the tape drive. If a customer is having a problem with a tape drive or 
simply desires to know a tape drive’s status or configuration, that customer should call 
Sun Microsystems StorageTek Support and the status, service, or configuration 
questions will be answered by a technician. A support technician might need to connect 
to the tape drive by way of the remote service capability for which the SDP unit is 
designed and intended to provide. If a tape drive configuration change is needed at an 
SDP/T10000 tape drive site, the reconfiguration service will be provided remotely for 
the customer as part of the site service agreement. If at any point these services cannot 
be fully satisfied remotely by way of the SDP, SUN will dispatch a service 
representative to the site to provide the necessary customer service. 
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Minimum Operating System 
Requirements
These are the minimum system operating requirements for this Virtual Operator Panel 
installation: 

■ Windows 2000 or XP 

■ Linux–Redhat 9.0, ES 

■ Solaris–SunOS 5.8, SunOS 5.9, and SunOS 5.10

Software Installation

Note – If you have installed an earlier version of the VOP on a computer, use the 
README.txt file for quick installation instructions for the upgrade. 

The software installation involves two separate pieces of software. First you need to 
either ensure that the Java software is installed, or install it. Then you will need to 
install the VOP software. 

Java Installation
To install the virtual operator panel on your computer: 

Note – These instructions were correct at the time of this writing. Sun can choose to 
change that Web site which would necessitate your having to search for the Java 2 
Platform listed below. 

1. Go to http:\\www.sun.com 

2. Click Downloads 

3. At the top of the screen, find Downloads and scroll over it. That will produce a 
drop-down menu. 

4. Click Java 2 Standard Edition 

5. Find the link for J2SE 1.4.2 and click that 

Note – The VOP was developed with version 1.4.2. 

6. On the next screen, find the link for Download J2SE_JRE and click that link (this is 
under the J2SEv 1.4.2_10 JRE title bar) 

7. On the next page, click the Accept radio button 

www.sun.com
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8. Find the platform you are using. Click either the online or offline installation for 
your platform 

9. Follow the on-screen instructions. This will download a compressed file to your 
computer – remember where it went! 

10. Change directories to the directory to which you downloaded the java file 

11. Double click (or run, if using a command line) the file you downloaded to install it 
and follow the on-screen prompts. 

VOP Software Installation
First, Insert the Sun provided VOP CD into your computer’s CD ROM drive. Then:

For Microsoft Windows Installations
1. If there is an existing VOP folder, rename an existing VOP folder to VOP_old, 

uninstall it, or remove it.

2. Double-click the zip file. A pop-up window like the one shown in the following 
figure appears. 

FIGURE 1-1 Winzip Window
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3. Click Extract on the WinZip box. A window like the one shown in the following 
figure will appear. 

4. Choose the directory of your choice.

Note – If you use the C:\Windows\Temp or C:\Temp folder, be sure to remove 
anything there first so you can tell the new files from the old ones that tend to 
accumulate there. In the previous example, the directory C:\Temp2 was created for this 
extraction; the before mentioned temporary directory had other files in them. 

5. Click Extract on the WinZip Window (see the previous figure). 

6. Once the files have extracted, close the WinZip Window.

7. Installation:
■ For Automatic installation, double-click Setup.exe. This will put the VOP files 

in the folder: 
C:\Program Files\VOP_Rel_1_0_8_Customer.

Note – The actual path will vary with the software release level.  
 
Pay attention to the name of the directory into which the installation program is 
extracting the files. You will have to go to that directory to start VOP or create a 
shortcut for the desktop. You will also need that directory path if you want to update 
the computer’s search path for commands. 

■ For manual installation:

i. Create a new folder labeled C:\Program Files\VOP_Rel_1_0_8_Customer. 
(This is the suggested folder. Earlier versions used other folder names, and any 
of those still work.)

ii. In the folder where you extracted the contents of the zip file, copy the contents 
of the folder \Windows\VOP into the new VOP folder. 

FIGURE 1-2 WinZip Directory Selection
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Note – For ease of operation after a manual installation, add the VOP folder to the path 
line. See “Computer Path Additions for Windows 2000 and XP” on page 67. Remember, 
you will have to change that path with each new version of VOP. 

Note – A copy of the VOP user’s guide is included in the zip file and was extracted 
into the temporary directory. Put it in a safe place before executing the next step. 

8. Delete the files you extracted from the zip file in the temporary folder (in the 
previous example that was Temp2). These files are no longer needed (however, see 
the previous note). 

9. Now you will need to modify the sunVOP.bat file if you wish to enable the heart 
beat feature. To do this:

a. In the VOP directory into which the VOP files were installed, find the 
sunVOP.bat file.

b. Open the sunVOP.bat file in a text editor such as Notepad. The file should look 
like:

#   %1 is optional drive ip address to connect to

java -classpath "lib;lib/VOP.jar;lib/borland.jar" -
Djava.security.policy=rmi.policy 
com.storagetek.VOPmain.CustomerVOPMain -b %1

cd bin

Note – The simpler the text editor used the better. Some word processing programs 
may imbed code that will interfere with the batch file running, even though you saved 
the file as a text file. 

c. If the -b is not there, add it. 

d. Save the file. 

For Unix or Linux Installations
1. Rename an existing VOP installation to VOP_old.

2. Make a new directory labeled VOP. This would typically be done in the root 
directory. 

3. Copy the zip file to the temporary directory for installation. 

4. Enter the command unzip VOPRelxxxCustomer.zip (xxx is the release version of 
the VOP) and extract the files into the same temporary directory.

5. Copy the files located in the new directory linux_unix\VOP to the VOP directory. 

6. Delete the contents of the temporary directory as they are no longer needed. 

7. Now modify the sunVOP file if you wish to enable the heart beat feature. To enable 
the hear beat feature:
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a. In the VOP directory into which the VOP files were installed, find the sunVOP 
file.

b. Open the sunVOP file in a text editor such as Vi. The file should look like:

#!/bin/ksh

#cd $HOME/VOP

#   $1 is optional drive ip address to connect to 
VOPdir=`echo $0 |sed 's!/VOP/.*!/VOP!'` vopdir2=`echo 
$VOPdir |grep "\.\/" |wc -c` if [ $vopdir2 -ne "0" ] 
then VOPdir="./" fi chkVOPdir=`echo $VOPdir |wc -c` 
if [ $chkVOPdir -lt "3" ] then VOPdir=`which $0| sed 
's!$0!!'` fi cd $VOPdir java -classpath 
"lib:lib/VOP.jar:lib/borland.jar" -
Djava.security.policy=rmi.policy 
com.storagetek.VOPmain.CustomerVOPMain -b $1 &

c. If the -b shown on the last line of this example is not there, add it. 

d. Save the file. 

8. Enter the command rehash. 

9. Make sure the java/j2re1.4.2_10/bin and VOP/bin folders are in the search 
path on the computer1. 

10. Solaris and Linux only – Do one of the following:

■ Create the .netrc file with the makeNetrc utility: 

i. Find the makeNetrc file in the /bin directory. 

ii. Run the makeNetrc file. This will make an entry for each T10000 tape drive 
found. This utility will prompt your for a node name or IP address for each 
T10000 tape drive and generate a .netrc entry for it. 

■ Create the .netrc file manually in the home directory: 

i. Type vi .netrc 

ii. Enter one of the following two lines for each tape drive in the domain. You are 
specifying each tape drive by either its serial number or IP address. 

■ To specify a tape drive by its node name: 
machine T10000-<last 9 digits of serial number> login stktape password 
stktape 

Note – The default node name is the tape drive’s serial number. You can change this. 

■ To specify a tape drive by its IP address: 

machine <IP address (for example: 129.80.5.67)> login stktape 
password stktap 

e. Enter “:wq” to exit vi. 

1. For LINUX and UNIX systems, this will require that you change the $PATH variable in the .cshrc 
file to include the java/bin directory. And, in the CLASSPATH file, add the path to the java 
directory. 
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11. Enter “chmod 400 .netrc”. 

12. Run the checkNetrc file on the distribution CD to verify that the .netrc file is 
correct. 

Note – The .netrc file contains data for logging in to a remote host over the network 
for file transfers by FTP. This file resides in the user's home directory on the machine 
initiating the file transfer. Its permissions should be set to disallow read access by 
group and others. (For more information, check the man netrc help file.) 

Changing the Computer’s IP Address
Under normal circumstances, the computer probably accesses a DHCP server to 
automatically obtain an IP address. These instructions change that connection to a static 
connection for connecting directly to a tape drive and then back to automatic mode so  
the computer can reconnect to the corporate network once again. 

Changing the Computer to a Static IP Address
These instructions connect a computer to a T10000 tape drive with the default IP 
Address. You will need to change the computer’s IP address on the Ethernet card to an 
address other than that used by the tape drive. To do that, perform the following steps: 

Note – This is for Windows 2000 - Windows XP is similar. 

1. Click Start in the lower left of the screen. 

2. Click Settings. 

3. Click Network and Dial-up Connections. 

4. Click Local Area Connection. A dialogue box as shown in the following figure 
appears. 
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5. Click Internet Protocol (TCP/IP) to highlight it as shown in the following figure.  

6. Click Properties in the Local Area Connection Properties dialogue box. The dialogue 
box of the following figure appears.

7. Click Use the Use the following IP address radio button as shown in the following 
figure. 

FIGURE 1-3 Local Area Connection Dialogue Box

FIGURE 1-4 Internet Protocol (TCP/IP) Properties Dialogue Box
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a. Enter the default IP address of 10.0.0.2 (The tape drive’s default IP address is 
10.0.0.1, so the computer must be an unused IP address. Since you are connecting 
directly to the tape drive, anything but the address of 10.0.0.1 should work.)

b. Enter the subnet mask 255.255.255.0 

8. Click OK in the Internet Protocol (TCP/IP) Properties dialogue box. (See the bottom 
of the previous figure.) 

9. Click OK in the Local Area Connections dialogue box. (See the bottom of FIGURE 1-3 
on page 28.) 

10. Start the VOP and connect to the tape drive. 

Changing A Computer to a Dynamic IP Address
These instructions are provided in the event that you need to change the computer’s 
local connection back to a dynamic IP address. 

Note – Some computers that use an Ethernet connection can to connect to a corporate 
Intranet/Internet connection without having to change the local settings. In these cases, 
you can be able to switch cables, reboot and not have to change the local settings. 

To change the computer’s settings to a dynamic IP address, perform the following 
steps: 

1. Click Start in the lower left of the screen. 

2. Click Settings. 

3. Click Network and Dial-up Connections. 

4. Click Local Area Connection. A dialogue box as shown in FIGURE 1-3 on page 28 
appears. 

5. Click Internet Protocol (TCP/IP) to highlight it as shown in FIGURE 1-3 on page 28. 

6. Click Properties in the Local Area Connection Properties dialogue box. The dialogue 
box in the following figure appears. 

7. Click Obtain an IP address automatically (radio button) as shown in the following 
figure.
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8. Click OK in the Internet Protocol (TCP/IP) Properties dialogue box. 

9. Click OK in the Local Area Connections dialogue box. 

The computer is now configured to reconnect to the corporate network and will 
automatically obtain an IP address when you connect to the network. 

FIGURE 1-5 Internet Protocol (TCP/IP) Properties Dialogue Box
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CHAPTER

 

2

Single Drive Operation

You can install the VOP software on a platform (running Win2000, Windows XP, 
LINUX, or Solaris) that can connect to the tape drives with an Ethernet connection. 
Like all other Sun/StorageTek remote diagnostic functions, the VOP does not allow 
anyone to read or write customer data. This software will allow you to erase a tape, but 
customer type data cannot be written to the tape, changed, or read. 
The VOP has two basic uses: 

■ Drive monitoring and operation 
■ Drive configuration 

Starting VOP
The command line has four options. These are:

-size x y  This will change the size of the displayed VOP screen

-verbose  This will record telnet traffic character by character

-b For the heart beat feature

<node name or IP Address>  This is used to automatically connect to the 
tape drive 

Note – For help on running the command line command sunVOP, add the -h 
parameter. 

If the VOP was installed with the automatic installation (Windows only), then the 
VOP will have a shortcut on the program list. Click the Start button, then click 
Programs > VOP_Rel_1_0_8_customer > VOP_Rel_1_0_8_customer. 

Note – The actual path name will vary with the release level. 

If the VOP was installed with the manual installation (Windows, Solaris, LINUX, 
and UNIX):
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Windows: To find the command line click the Start button in the very lower left 
corner of the monitor screen. Then click the word Run... . This brings up a command 
line screen as shown in the following figure. The exact path will vary depending on 
where you put the VOP files.  

Starting the VOP with the command line can be done with or without the drive’s IP 
address. Both methods are shown. See the following two sections. 

With the Drive IP Address
1. From a command line, enter the command:

sunVOP <IP address>
Where the IP address would be 10.0.0.1 if you are connecting to a new drive, or 
the IP address or node name of a drive already configured.

2. Press the Enter key.

Once successfully connected to the drive, the IP address or the device name appears 
on the upper part of the screen.  

Without the Drive IP Address
1. From a command line, enter the command sunVOP, or use the shortcut and click the 

Start button, then click Programs > VOP_Rel_1_0_8_customer > 
VOP_Rel_1_0_8_customer.

2. Once the VOP has started, you will need to connect to the drive. This is done by the 
following:

a. Click File > Connect to Drive.

FIGURE 2-1 Run Command Line
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b. In the dialogue box as shown in the following figure, enter the IP address (or 
alias) of the drive. Enter the value 10.0.0.1 for an unconfigured new drive, or the 
IP address of a configured drive. 

c. Click OK to finish the connection. Once you have successfully connected to the 
drive, the IP address or name of the drive appears at the top of the screen.

Custom Batch Files

You can edit the sunVOP file, rename it, and specify a tape drive in that file. This would 
give you a list of batch files to start the VOP and have it connect to a specific tape drive 
without having to type in the IP address of that tape drive. 

Windows Batch Files

The original sunVOP.bat file looks like this (depending on the editor, this could all be 
one line):

#  %1 is optional drive ip address to connect to 
java -classpath "lib;lib/VOP.jar;lib/borland.jar" -
Djava.security.policy=rmi.policy 
com.storagetek.VOPmain.CustomerVOPMain -b %1 
cd bin

The item of interest is the second %1 near the end of the file (bolded in the preceding 
example).  Change that to the tape drive’s IP address (or alias) and rename the file as 
you save it. For example, a tape drive known as ngdtape02 would have a runVOP.bat 
file named runVOP_ngdtape02.bat. The contents of which would be: 

#  %1 is optional drive ip address to connect to 
java -classpath "lib;lib/VOP.jar;lib/borland.jar" -
Djava.security.policy=rmi.policy 
com.storagetek.VOPmain.CustomerVOPMain -b ngdtape02 
cd bin

FIGURE 2-2 IP Address Dialogue Box
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Linux, Solaris, and UNIX Files

The original sunVOP file looks like this (depending on the editor, this could all be one 
line):

#!/bin/ksh 
#cd $HOME/VOP 
#   $1 is optional drive ip address to connect to 
VOPdir=`echo $0 |sed 's!/VOP/.*!/VOP!'`  
vopdir2=`echo $VOPdir |grep "\.\/" |wc -c` 
if [ $vopdir2 -ne "0" ] 
then 
VOPdir="./" 
fi 
chkVOPdir=`echo $VOPdir |wc -c` 
if [ $chkVOPdir -lt "3" ] 
then 
VOPdir=`which $0| sed 's!$0!!'` 
fi 
cd $VOPdir

java -classpath "lib:lib/VOP.jar:lib/borland.jar" -
Djava.security.policy=rmi.policy 
com.storagetek.VOPmain.CustomerVOPMain -b $1 &

The item of interest is the second $1 (bolded) near the end of the file. Change that to 
the tape drive’s IP address or alias (bolded in the following example) and rename the 
file as you save it. For example, a tape drive known as ngdtape02 would have a 
runVOP file named runVOP_ngdtape02. The contents of which would be:

#!/bin/ksh 
#cd $HOME/VOP 
#   $1 is optional drive ip address to connect to 
VOPdir=`echo $0 |sed 's!/VOP/.*!/VOP!'`  
vopdir2=`echo $VOPdir |grep "\.\/" |wc -c` 
if [ $vopdir2 -ne "0" ] 
then 
VOPdir="./" 
fi 
chkVOPdir=`echo $VOPdir |wc -c` 
if [ $chkVOPdir -lt "3" ] 
then 
VOPdir=`which $0| sed 's!$0!!'` 
fi 
cd $VOPdir 
java -classpath "lib:lib/VOP.jar:lib/borland.jar" -
Djava.security.policy=rmi.policy 
com.storagetek.VOPmain.CustomerVOPMain -b ngdtape02 &
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VOP Screen
The following figure shows the VOP main screen and its various areas.      

FIGURE 2-3 VOP Screen  

Figure Reference Meaning

1 Menu bar, including the tape drive’s IP address or node name. 

2 Status indicator buttons*

* The status button at the bottom of this set only shows when the tape drive is in encrytpion mode. For the various 

labels and meanings of this additional button, see the document Crypto Key Management Station Key Management 

System User’s Guide PN 96262. 

3 Primary front panel screen

4 Alternate front panel screen

5 VOP main display screen

6 Display of a standard label of a data cartridge

Note: The primary and alternate front panel screens are the messages that would be displayed on a tape drive with 
a front panel. On the front panel, these two messages would alternate. On the VOP they are displayed side by side.
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VOP Indicators
The buttons (at the top and slightly to the right of center of the VOP screen) indicate 
Loaded, On-line, Clean, and Dump (top to bottom). The following table defines the 
color meanings of these buttons.  

TABLE 2-1 VOP Button Colors Defined  

Button Color Button Meaning

Black All There is no connection to this tape drive

Sun Blue Loaded and On-line Indicates that the condition is true 

Grey All Indicates that the condition is not true

Orange Dump, Status 
(encryption)*, and 
Clean

* The status button at the bottom of the VOP buttons  only shows when the tape drive is in encrytpion mode. For its various labels, colors, 
and meanings see the document Crypto Key Management Station Key Management System User’s Guide PN 96262. 

Indicates there is a problem - either the drive needs to be cleaned (the 
Clean button is orange) or there is a service problem (the Dump 
button is orange) 

Magenta On-line and Off-line Indicates that the drive is in transition from online to offline, or from 
offline to online

Sun Blue Heart Alternates between Sun blue and grey at the rate of one color change 
per second. This indicates the connection to the drive is active.
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Menu Selections
This section discusses the drop-down menus and the options under each menu. 

File
The following figure shows the drop-down options under File.  

The meaning of these items is explained in the following sections. 

Clear Transcript
This function clears the text on the lower part of the VOP screen. You could consider it 
to be a clear screen command. 

Connect to Drive
This function is used to establish a connection to a drive. Choosing this function will 
result in the dialogue box of FIGURE 2-2. Once the IP address is entered, the VOP will 
attempt to establish a connection to the desired tape drive. 

Exit
This function quits the VOP. 

FIGURE 2-4 File Options
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Drive Operations
The following figure shows the drop-down options under Drive Operations. However, 
the functions for making a tape of any sort and rebuilding the media information 
region (MIR) are not available in the online state. These only become usable when the 
drive is offline as shown in the following figure. 

The meaning of these items is explained in the following sections.

Load Tape
This function causes a cartridge in the input tray to load. 

Unload Tape
This function causes a loaded cartridge to rewind and unload. 

Set Online or Set Offline
■ When the tape drive is online, this function reads Set Offline. Clicking on Set 

Offline will cause the tape drive to go offline. 

■ When the tape drive is offline, this function reads Set Online. Clicking on Set 
Online will cause the tape drive to go online. 

IPL Drive
This function will cause the tape drive to perform an initial program load (IPL). 
Communication with the drive by way of the VOP will be lost. 

Force Dump
This function will force a dump. This dump will be stored in the tape drives internal 
memory and the Dump light will change from grey to red. 

FIGURE 2-5 Drive Operation Options
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Format Tape
This function has a submenu as shown in the following figure. 

The buttons of the bottom of the Format Tape submenu have the following functions:
■ Make This begins the current operation.
■ Abort This terminates the current operation.
■ Done This stops the current operation. See the Make functions below. Some will 

format one cartridge after the other until you click on Done after the last one. 

To change the formatting of a tape, do the following:

1. Select the desired function from the list shown in the previous figure. 

2. Click Make. You will be prompted to insert the cartridge at that time. 

Note – For the specifics of the Make or Rebuild function you are using, see the 
headings that follow. 

3. Click Done when you have competed the operation. 

4. Click Drive Operations > Set Online to return the tape drive to the online state.

The tape drive is now ready to resume normal operations. 

Make Data Tape

To make a data cartridge: 

Caution – Data security issue: The make data tape function does not do a data 
security erase on a tape. If you are doing a quick format on a tape, the old data is still 
there. It just is not retrievable by ordinary means, but it is still there. 

Note – Make sure the data cartridge’s write protect switch is set to the Unlocked 
position. 

FIGURE 2-6 Format Tape Submenu
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1. Click Drive Operations > Set Offline. 

2. Click Drive Operations > Format Tape... > Make Data Tape. 

Note – This function can be aborted after it has started by clicking Abort on the Format 
Tape submenu. 

3. Remove any data cartridge currently loaded in the tape drive (beginning this 
operation will unload any cartridge currently loaded). 

4. Follow the VOP screen prompts and load the standard data cartridge that you want 
either logically erased or load a new data cartridge. 

Note – A successful data cartridge build will result in the tape drive automatically 
unloading the data cartridge. 

Note – If an attempt to make a data cartridge fails:

■ The message part of the VOP screen will contain a failed message and an FSC. 
■ The tape drive will NOT automatically eject the data cartridge. 

Caution – Tape damage: Any resistance to removing the data cartridge, beyond the 
usual friction between the data cartridge case and the tape drive, probably indicates 
that the leader is not fully rewound.  
If you believe the leader is not fully rewound, attempt another load operation (click 
Drive Operations > Load) followed by another unload operation (click Drive 
Operations > Unload). If a load and unload operation fails to correct the situation, 
contact a service representative about a possible stuck data cartridge. Do not forcibly 
remove a data cartridge. Attempt another build of the data cartridge before deciding 
that the data cartridge is defective. Click Drive Operations > Unload and after the data 
cartridge unloads, gently push it back into the tape drive until it lowers onto the hub 
assembly to reload it. 

5. When prompted, remove the data cartridge. 

6. If the cartridge you unloaded was the last or only cartridge you needed to format, 
continue on to the next step. If there are other cartridges to format, return to Step 4. 

7. Click Done on the Format Tape submenu. 

8. Click Drive Operations > Set Online.

This completes the process of creating data cartridges and returns the tape drive to an 
online state. 

Make Code Tape

This function transfers the current microcode of a tape drive onto a cartridge. You will 
need either a dump cartridge or a data cartridge before beginning this function.
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This function will cause the tape drive to unload any cartridge loaded when this 
function is selected.

To make a code cartridge: 

1. Make sure the cartridge’s write protect switch is set to the Unlocked position. 

2. Click Drive Operations > Set Offline. 

3. Click Drive Operations > Format Tape... > Make Code Tape. 

Note – This function can be aborted after it has started by clicking Abort on the Format 
Tape submenu. 

4. Remove any cartridge currently in the tape drive. 

5. Follow the VOP screen prompts and load the dump cartridge on which you want to 
load the tape drive’s code.

Note – A successful code cartridge build will result in the tape drive automatically 
unloading the cartridge. 

Note – If an attempt to make a code cartridge fails: 
The message part of the VOP screen will contain a failed message and an FSC.  
The tape drive will NOT automatically eject the cartridge. 

Caution – Tape damage: Any resistance to removing the cartridge, beyond the usual 
friction between the cartridge case and the tape drive, probably indicates that the leader 
is not fully rewound.  
If you believe the leader is not fully rewound, attempt another load operation (click 
Drive Operations > Load) followed by another unload operation (click Drive 
Operations > Unload).  Do not forcibly remove a cartridge. 

6. When prompted, remove the cartridge. 

7. Click Done on the Format Tape submenu. 

8. Click Drive Operations > Set Online. 

This completes the process of creating code cartridges and returns the tape drive to an 
online state. 

Make Dump Tape

This function reformats a stock cartridge or code cartridge into a special dump 
cartridge. This dump cartridge is used for some diagnostic functions and moving log 
files (dumps) from the tape drive onto this cartridge. 

A dump is only of use to Sun disk engineering or tier 3 support. It is a large data file 
that contains information about the contents of various registers in the tape drive’s 
microprocessor, sensor conditions, and other statistical information relating to the 
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condition of the tape drive at the time an error occurred that resulted in the tape drive 
creating the dump. This dump cannot be analyzed by a custom or a service 
representative at the customer’s site.

Note – The procedure for getting a dump cartridge into and out of a tape drive inside 
a library is beyond the scope of this book. That procedure is usually site specific. 

Note – Make sure the cartridge’s write protect switch is in the Unlocked position. 

Dump cartridges are created from data cartridges or code cartridges by:

1. The tape drive must be in an offline state. If the display shows Online, click Drive 
Operations > Set Offline. This sets the tape drive to the Offline state. 

2. Click Drive Operations> Format Tape... > Make Dump Tape. 

Note – This function can be aborted after it has started by clicking Abort on the Format 
Tape submenu. 

3. Follow the VOP screen prompts and directions. 

Note – A successful dump cartridge build will result in the tape drive automatically 
unloading the cartridge. 

Note – If an attempt to make a dump cartridge fails:

■ The message part of the VOP screen will contain a failed message and an FSC. 
■ The tape drive will NOT automatically eject the cartridge. 

Caution – Tape damage: Any resistance to removing the cartridge, beyond the usual 
friction between the cartridge case and the tape drive, probably indicates that the leader 
is not fully rewound.  
If you believe the leader is not fully rewound, attempt another load operation (click 
Drive Operations > Load) followed by another unload operation (click Drive 
Operations > Unload). If a load and unload operation fails to correct the situation, 
contact a service representative about a possible stuck cartridge. Do not forcibly 
remove a cartridge. Attempt another build of the dump cartridge before deciding that 
the cartridge is defective. Click Drive Operations > Unload and after the cartridge 
unloads, gently push it back into the tape drive until it lowers onto the hub assembly to 
reload it. 

4. When all cartridges that you wish to convert to dump cartridges have been 
converted, click Doneon the Format Tape submenu. 

5. Drive Operations > Set Online. 

This completes the building of one or more dump cartridges. The tape drive is now 
back online and ready for normal operations. 
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Rebuild MIR

This function is used when the media information region (MIR) of tape on an existing 
data cartridge has been damaged or is otherwise unusable. Choosing this function will 
cause the tape drive to rewrite the MIR on the tape of the loaded data cartridge. 
Because the entire written part of the tape must be read, this takes time. This function 
can be aborted after it has started with the abort button at the top of the screen. 

To rebuild the MIR from the VOP: 

Note – This can be a lengthy process, especially on a fully utilized cartridge. 

1. The tape drive must be in an offline state. If the display shows Online, click Drive 
Operations> Set Offline. This sets the tape drive to the Offline state. 

2. Click Drive Operations > Format Tape... > Rebuild MIR. 

Note – This function can be aborted after it has started by clicking Abort on the Format 
Tape submenu. 

3. Follow the on-screen prompts and directions. 

Note – If more than one tape has a defective MIR, the next cartridge is loaded into the 
tape drive when the VOP screen displays the prompt to load a customer cartridge. This 
process continues until all defective MIRs have been rebuilt. 

Note – A successful MIR rebuild will result in the tape drive automatically unloading 
the cartridge.

If an MIR rebuild fails:

■ The message part of the VOP screen will contain a failed message and an FSC. 

■ The tape drive will NOT automatically eject the cartridge. 

Caution – Tape damage: Any resistance to removing the cartridge, beyond the usual 
friction between the cartridge case and the tape drive, probably indicates that the leader 
is not fully rewound.  
If you believe the leader is not fully rewound, attempt another load operation (click 
Drive Operations > Load Tape) followed by another unload operation (click Drive 
Operations > Unload Tape). If a load and unload operation fails to correct the 
situation, contact a service representative about a possible stuck cartridge. Do not 
forcibly remove a cartridge. 

■ Attempt another rebuild of the MIR before deciding that the MIR part of the tape 
in that cartridge is defective. Click Drive Operations > Unload Tape and after the 
cartridge unloads, gently push it back into the tape drive until it lowers onto the 
hub assembly to reload it. 

4. When all cartridges with defective MIRs have been repaired, click the Done button 
on the format selection submenu. 

5. Drive Operations > Set Online. 
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This completes the rebuild of the MIR on one or more cartridges. The tape drive is now 
back online and ready for normal operations. 

Note – The next two items, Reset Drive and Zero Drive do not appear on the menu for 
tape drives that do not have the encryption feature enabled. 

Reset Drive
This option is used on encryption drives to remove all media keys and device keys 
from the drive. The drive will be inoperable until both are reloaded. 

Zero Drive
This function destroys the tape drive. It meets the FIPS requirement that allows you to 
destroy the drive. There is a dialogue box that appears to confirm your decision to 
destroy the drive before this function is executed. 

Caution – This function deletes all the keys including the internal enabling key and it 
renders the drive useless. All you can do after executing this function is send it back to 
Sun and have it rebuilt.  

Retrieve
The following figure shows the options available under Retrieve.  

The meaning of these items is explained in the following sections.

View Drive Data
Clicking View Drive Data presents the five tabs:

■ Encrypion (FIGURE 2-8)

■ Fibre (FIGURE 2-9) 

■ Manufacturing (FIGURE 2-11)

FIGURE 2-7 Retrieve Options
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■ Network (FIGURE 2-12)

■ Radio Frequency Identification (RFID) (FIGURE 2-13)

■ Version (FIGURE 2-14)

These are information only displays. As shown in the following figures, The display 
varies slightly depending on the interface setting (Fibre or FICON). 

Note – The Encrypt tab only shows on drives that have the encription option enabled. 

FIGURE 2-8 Retrieve > Drive Data > Encrypt (encryption)



 

Menu Selections

46 VOP User’s Guide • October 2006 Revision H • 96179

FIGURE 2-9 Retrieve > Drive Data > Fibre Tab (Set to Fibre)
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FIGURE 2-10 Retrieve > Drive Data > Fibre Tab (Set to FICON)
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FIGURE 2-11 Retrieve > Drive Configuration > Manufacturing Tab
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FIGURE 2-12 Retrieve > Drive Configuration > Network Tab
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FIGURE 2-13 Retrieve > Drive Configuration > RFID Tab
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View Date & Time
This function displays the tape drive’s date and time in the lower part of the window. 
See “Set Clock” on page 63 if the time and date are not correct. 

FIGURE 2-14 Retrieve > Drive Configuration > Version Tab
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Dumps to File
Choosing to copy the dump to a file will create a file and you will need to select a 
folder on the computer where you want this file placed. The dialogue box for this 
operation is shown in the following figure. 

Perms to File
This is a text file list of all the permanent errors taken by the drive. Choosing to copy 
this file to the computer uses the same dialogue box as shown in the previous figure. 

Logs to File
Copying the logs to a file uses the same dialogue box as shown in the previous figure. 

Get and Display Logs
This function retrieves the event log currently on the tape drive and displays that log 
file in main VOP viewing area. 

Configure

Note – The tape drive must be offline do display the Configure submenu items. 

Caution – Improper settings can render a drive useless–Only change the settings for a 
drive if you are sure of what you are doing. 

FIGURE 2-15 Save Dialogue Box
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The following figure shows the options available under Configure.  

Note – While viewing the various tabs under Drive Data, if you change any setting 
and then change your mind and click Cancel at the bottom of the window, you will still 
get the message shown in the following figure. Click No to fully cancel that change. 

This can be avoided by clicking the check in the box to the right of the item you 
changed. This check box is in the column labeled Update (see the figure on the next 
page).

Drive Data
There are two tabs for settings under the Configure > Drive Data sub menu.

Configure > Drive Data > Fibre Tab

There are two versions of this tab, depending on the Channel Interface Type setting 
near the bottom of this tab. One is for the Fibre settings and the other is for the FICON 
settings.

FIGURE 2-16 Configuration Options

FIGURE 2-17 Changes Pending Dialogue Box
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The Fibre tab (and set to Fibre as shown near the bottom of the screen) and its setting 
options are shown in the following figure.  

FIGURE 2-18 Configure Drive Data’s Fibre Settings (Fibre Settings)
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The Fibre tab (and set to FICON as shown near the bottom of the screen) and its setting 
options are shown in the following figure.  

The pull-down and fill-in Parameter Values are explined in the following sections:

Emulation options:The emulations available depend on the Channel Interface 
selected. 

■ Fibre Channel options: 

FIGURE 2-19 Configure Drive Data’s Fibre Settings (FICON Settings)

TABLE 2-2 Emulation Pull-down Menu Options

Option Use/Meaning

Standard T10000 tape drive functionality

9840B*

* The use of the 9X40 emulation mode is only recommended for early evaluation when other drivers may not be available. 
This mode is not recommended for normal operations.

Emulates a StorageTek T9840B tape drive

9940B Emulates a StorageTek T9940B tape drive (see note for 9840B))

3592 Emulates an IBM 3592 tape drive

F2483 Emulates a Fujitsu F2483 tape drive
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■ FICON Channel options:

VSM3490—Used in conjunction with a StorageTek Virtual Storage Manager.

3592—Emulates an IBM 3592 tape drive.

Data Compression:

The Data Compression option controls how the tape drive and host will deal with 
data compression.  

Data Security Erase:

The Full DSE option controls the type of data security erase (DSE) performed.   

Standard Label Protect

When set to Yes, this option prevents a tape from overwriting the tape label with 
user data in the event that a tape drive performed a rewind or unload/reload of a 
tape. A tape can be manually unloaded and reloaded through the front panel, VOP, 
or a Library. If the customer’s job is unaware of this, the tape will be mis-positioned 
when the job resumes.

Criteria:

1. A write is allowed when the first or second block is a tape mark (file mark).

2. A Write is allowed over the first block if it is an 80 byte block and has "VOL1" as the 
first 4 characters in either ASCII or EBCDIC.

3. A Write is allowed over the second block, if it is an 80 byte block.

4. In all other cases, a write at either block 0 or 1 produces a permanent error reported 
which is returned to the host.

TABLE 2-3 Data Compression Options

Option Use/Meaning

Yes Data compression is set to On by default on power on/reboot. This may be overridden by 
the host for a job. 

No Data compression is set to Off by default on power on/reboot. This may be overridden by 
the host for a job. 

Off Compression is turned Off on power on/reboot and the host cannot override this setting 
for jobs as is the case then this option is set to Yes or No. 

TABLE 2-4 Data Security Erase Options

Option Use/Meaning

Yes This allows for a full data security erase. This is a time-consuming operation. 

No No full DSE; however, the tape drive writes a mark on the tape and prevents access to old 
data on that tape. 
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5. Writes at blocks 2 through the maximum are not checked.

Library Address:

Valid entries are library dependant – see the library documentation for the library in 
which the tape drive is being installed. For libraries that do not use a serial interface, the 
entry may be left blank or set to FF; this is the drive's library address on the serial 
interface (sometimes called the tape transport interface of the 9310 library). This is a 
manual service representative entry. 

Tape Completion

This option turns the tape bar on and off. 

Note – This option is not functional for this code release. 

Language: 

This option sets the language in which most operational text displays (loading, 
unloading and so on) will be presented.    

TABLE 2-5 Standard Label Protect Options

Option Use/Meaning

Yes Enables standard label protection. 

No Disables standard label protection. 

TABLE 2-6 Pa/Pb hrd asgn phsy addr Options

Option Use/Meaning

Yes Enables the tape bar. 

No Disables the tape bar.  

TABLE 2-7 Language Pull-down Menu Options

Option Use/Meaning

English Normally, the language most commonly used in the data center will be selected. 

Espanol

Francais

Italiano

Deutsch
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World Wide Name:

The WWN is a 64-bit address used in Fibre Channel. The tape drive comes with a 
WWN assigned at the factory, but this address can be changed. The following table 
displays the parenthetical information that displays to the right of the field identifier, 
indicating where this name originated. 

Note – This is the WWN of the drive, not to be confused with the WWN of either of the 
two ports on the drive. 

Pa (or Pb) hrd asgn phsy addr:

This option is used to enable or disable a hard physical address of the port. 

Pa/Pb arbtrtd loop addr:

This displays the 24-bit Address Identifier (AI) assigned to the port at interface 
logon. This is in the form of xyyzz, where:

In an Arbitrated Loop 

xx = domain (bits 23-16) 

yy = area (bits 15-08) 

zz = PA (bits 07-00) 

In a Fabric log on 

xx = switch in the fabric 

yy = port on the switch 

zz = 00 (constant in a fabric) 

The following table shows the Arbitrated Loop Physical Address (AL_PA) by 
address (system) and index (decimal index) for the hard physical address 
configuration. Valid index entries are 000–125.

TABLE 2-8 World Wide Name Options  

Option Use/Meaning

Default This is the factory assigned number

Custom This is one that a service representative or customer entered

Library This is one that was assigned by the attached library*

* The library must support dWWN. The 9310 library does not support it while the others do. 

TABLE 2-9 Pa/Pb hrd asgn phsy addr Options

Option Use/Meaning

Yes Enables a hard physical address, manually set by the Pa(Pb) hrd asgn phsy addr Option 
menu item. If the preset hard address is not available at loop initialization, the drive then 
seeks a soft physical address. 

No Disables a hard physical address and causes the drive to seek a soft physical address 
assignment at loop initialization. The drive is shipped with No selected.  
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TABLE 2-10 Arbitrated Loop Physical Address 

PA 
xx

Index 
ddd

PA
xx

Index 
ddd

PA
xx

Index 
ddd

PA 
xx

Index 
ddd

PA 
xx

Index 
ddd

01 125 34 100 63 075 90 050 BC 025

02 124 35 099 65 074 97 049 C3 024

04 123 36 098 66 073 98 048 C5 023

08 122 39 097 67 072 9B 047 C6 022

0F 121 3A 096 69 071 9D 046 C7 021

10 120 3C 095 6A 070 9E 045 C9 020

17 119 43 094 6B 069 9F 044 CA 019

18 118 45 093 6C 068 A3 043 CB 018

1B 117 46 092 6D 067 A5 042 CC 017

1D 116 47 091 6E 066 A6 041 CD 016

1E 115 49 090 71 065 A7 040 CE 015

1F 114 4A 089 72 064 A9 039 D1 014

23 113 4B 088 73 063 AA 038 D2 013

25 112 4C 087 74 062 AB 037 D3 012

26 111 4D 086 75 061 AC 036 D4 011

27 110 4E 085 76 060 AD 035 D5 010

29 109 51 084 79 059 AE 034 D6 009

2A 108 52 083 7A 058 B1 033 D9 008

2B 107 53 082 7C 057 B2 032 DA 007

2C 106 54 081 80 056 B3 031 DC 006

2D 105 55 080 81 055 B4 030 E0 005

2E 104 55 079 82 054 B5 029 E1 004

31 103 59 078 84 053 B6 028 E2 003

32 102 5A 077 88 052 B9 027 E4 002

33 101 5C 076 8F 051 BA 026 E8 001

EF 000
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Pa/Pb soft asgn phsy addr:

This option chooses the order in which the soft physical address is found. 

Note –  The tape drive is shipped with Lo selected. The Solaris default FCP-driver 
behavior requires the config setting “Soft PA LO.” 

Pa/Pb Maximum Receive Size:

This is the maximum receive size in kilobytes. This option sets the maximum packet 
size that the drive can receive from the host.  

Note – For FICON, this needs to be set to 2048. Other values can cause problems.  
 
For Fibre Channel, the factory-shipped setting is 2112 but the other value of 2048 may be 
selected to accomodate the host processor - the setting needs to match other equipment 
on the network. 

Pa/Pb WWN override 

This is an address or name (alias) for port A (or port B).  

TABLE 2-11 Pa/Pb soft asgn phsy addr Options

Option Use/Meaning

Hi The drive seeks a soft PA in an ascending order at loop initialization. 

Lo The drive seeks a soft PA in a descending order at loop initialization. 

TABLE 2-12 Maximum Receive Size Options

Option Use/Meaning

2112 Unless there is a compelling reason to change this, the packet size would normally be set 
to the highest value. 

2048

1280

1024

768

TABLE 2-13 World Wide Name Override Options

Option Use/Meaning

Default This is the factory-assigned number

Custom This is one that a service representative or customer entered

Library This is one that was assigned by the attached library. 
Note: The library must support dWWN. The 9310 library does not support it while the 
others do. 
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Pa/Pb Speed Negotiation: 

This option sets the transfer speed between the host and the tape drive. These are radio 
buttons and the choices are 1GB, 2GB and 4GB.

Bottom of the Screen Buttons 

The buttons listed here are found on the bottom of the screen for each of the Configure 
> Drive Data tabs. 

■ Load File–This button allows you to load the options from a saved file on the hard 
drive, thus allowing you to configure drive after drive with the same configuration 
(as is usually the case) and only having to configure a few individual items such as 
its WWN. Clicking on this button brings up the Open dialogue box as seen in the 
following figure. Navigate to where you have the configuration files saved, click it, 
and then click Open. This action will load the configuration setting from the saved 
file to the tape drive’s PROM. Do not forget to change the address setting on each drive to 
its unique settings. 

■ Commit–This button loads the changes you have made to this configuration options 
page into the drives PROM. Clicking on this button closes this dialogue box. 

■ Cancel–This button aborts any changes you have made since opening this screen 
and closes this dialogue box. 

FIGURE 2-20 Open Dialogue Box
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Configure > Drive Data > Network Tab

The Network setting options are shown in the following figure. 

The fill-in Parameter Values are as follows:

IP Address

Valid entry is a standard IP address assigned by the customer. If DHCP is enabled, it 
will set this value.

Note – If a DHCP server is being used, the value shown here may not be the value in 
use by the DHCP server. The value used by the DHCP server is not displayed here–this 
is the last value manually entered.

Subnet Mask

Valid entry is a standard subnet mask assigned by the customer. If DHCP is enabled, 
it will set this value. 

Note – If a DHCP server is being used, the value shown here may not be the value in 
use by the DHCP server. The value used by the DHCP server is not displayed here–this 
is the last value manually entered.

FIGURE 2-21 Configure > Drive Data > Network Settings
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Gateway

Valid entry is a standard gateway address assigned by the customer. If DHCP is 
enabled, it will set this value. 

Note – If a DHCP server is being used, the value shown here may not be the value in 
use by the DHCP server. The value used by the DHCP server is not displayed here–this 
is the last value manually entered.

Network Node Name

Valid entries are either an alias name or an IP address assigned by the customer. If 
DHCP is enabled, it will set this value. 

Bottom Screen Buttons

See “Bottom of the Screen Buttons” on page 61. 

Save Drive Config
This configuration function saves the current drive settings to a file on the hard drive. 
Clicking on this menu item brings up the dialogue box as shown in FIGURE 2-15. 
Navigate to the directory in which you wish to save the configuration file, give it a 
name, then click Save. 

Set Clock
This function sets the clock of the tape drive to the time and date that the computer is 
showing. No messages appear on the screen. 

Load Code from Tape
This function loads the operational code for the tape drive from a code cartridge to the 
internal flash PROM of the tape drive. After the code load is complete and you unload 
the code cartridge, the tape drive will go through an IPL to load the new microcode. 

To load code from a cartridge:

1. Click Drive Operations> Set Offline. 

2. Click Configure > Load Code from Tape. 

Note – If there was a cartridge loaded into the tape drive, it will unload at this time. 

3. When prompted by the VOP screen, load the code cartridge into the tape drive. The 
pop-up dialogue box indicates the load progress. 

Caution – Possible code corruption: Do not disturb the tape drive while the code is 
loading from the code cartridge. 
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Note – While the code is loading from the code cartridge, the LED on the rear of the 
tape drive will be flashing a fast yellow. This is normal. If the LED turns to a fast 
flashing green, the code load is complete. If the LED turn to a solid color and is not 
flashing, this indicates an error condition. If an error condition exists on either the LED 
on the rear of the tape drive or on the front panel display screen of the tape drive, 
contact a service representative. 

Note – A pop-up dialogue box appears that will indicate the progress of the load. No 
user interaction is required for this dialogue box. 

4. When the VOP screen indicates that the code load is complete, the large white 
message area of the VOP screen will prompt you to removed the cartidge. Once the 
cartridge is removed, the drive will IPL and load the new code. 

Once the IPL is complete, the tape drive is online and is ready to resume normal 
operations. 

Help
The figure below shows the Help submenu. 

TABLE 2-14 Help Submenu
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Clicking on the About menu item displays the following dialogue box. 

Note – The actual content of the previous dialogue box will depend on the software 
release level. 

Click OK or the X box in the upper right corner to exit this dialogue box. 

FIGURE 2-22 About Dialogue Box
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APPENDIX

 

A

Computer Path Additions for 
Windows 2000 and XP

These directions are for adding the path for java\j2re1.4.2_05\bin and VOP\bin in the 
system environmental file. These instructions are for computers running Windows 
2000. Windows XP is nearly the same. 

Caution – Possible system operation problems: If you have never changed the path 
string on a personal computer, find someone who has to assist you with this operation. 
Corruption of the path string may make it difficult to start some programs and my 
make it impossible for them to operate. 

1. Click Start. 

2. Scroll to Settings and find Control Panel. 

3. Click Control Panel. 

4. Find the System icon and double-click it. 

5. Click Advanced tab, see FIGURE A-1 on page 68. 

6. Click Environmental Variables button. (It is in a different part of the screen in 
Windows XP.) 
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7. In the second pane down, titled “System variables,” click the Path item. This 
dialogue box is shown in the following figure. 

8. Click Edit. 

FIGURE A-1 System Properties (Windows 2000 shown)

FIGURE A-2 Environmental Variables
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9. The dialogue box of in the following figure appears. The java, VOP, and VOP\bin 
folders should be in that path. If they are not, add them to the end. 

Example of a path add:

The original path was:

C:\Program Files\Adobe;\Windows\Test 

Note – The actual path string will vary from one computer to another and will depend 
on whether you did an automatic installation of the VOP or put the files in another 
directory. 

With the Java directory added, it would look like this:

C:\Program Files\Adobe;\Windows\Test;\Program Files\
Customer;\Program Files\Customer\bin;\Program Files\
Java 

Note – Paths start from the main directory and are separated by a semicolon. The tape 
drive at the beginning of the line is assumed unless otherwise specified. 

10. With the path addition complete, click OK. This will return you to the 
Environmental Variables dialogue box (see FIGURE A-2 on page 68). 

11. At the bottom of the “Environmental Variables” dialogue box, click OK. This will 
return you to the System Properties dialogue box (see FIGURE A-1 on page 68). 

12. At the bottom of the System Properties dialogue box, click OK. 

13. This completes the search path addition. You need to reboot the computer to have 
this change take effect. 

FIGURE A-3 Edit System Variable
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APPENDIX

 

B

VOP in Multiple Drive Installations

The following is supplemental and recommended information for library and rack 
mount T10000 tape drive installations. 

The recommended method of connecting the tape drives to a host computer is shown 
here. It is beyond the scope of this document to explain all the permutations possible by 
using a dynamic IP addressing, routers, and switches. These instructions also assume 
that the tape drives and computer will either be in a private network, or the computer 
will have a separate network interface card (NIC) for connecting to the tape drives.  
does not recommend connecting the tape drives to a public network. The basics of the 
setup are shown in FIGURE B-1 on page 73. 

This information is also for customers who either chose not to use the  Service Delivery 
Platform (SDP) or whose security concerns will not allow the use of SDP. 

■ For security reasons, Sun recommends that you put tape drives on a private LAN

■ The IP address will be 10.0.0.xxx

■ Reserve 10.0.0.1 for the factory default IP address for tape drives 

■ Reserve 10.0.0.2 for the VOP computer 

■ Set up the IP addresses:

■ For Libraries, set the IP address of each tape drive to the library numbering 
scheme for tape drives. Set the node name to tape drive number. 

Note – If a drive slot is not populated, simply skip the number or numbers of drive 
slots that do not contain a tape drive. 

■ For rack mount drives, set the IP address and the node name. To make it 
easier and faster to identify a failing tape drive later, use a node name that 
the operators mounting cartridges use to identify this tape drive. 

To set each tape drive’s initial configuration, do the following:

1. Label each end of the Ethernet cable per the tape drive number and plug one 
connector into the switch. Do NOT connect the other end into the tape drive at this 
time. 

2. Install all of the tape drives with the Ethernet port NOT connected. Power each one 
on as they are installed. 

3. Connect an Ethernet cable from the host computer (the computer on which the VOP 
is installed) to the Ethernet switch box (see FIGURE B-1 on page 73). 
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Note – See the setup documentation for the switch box you are using. Some switch 
boxes have the host computer connected to a special port. 

4. Bring up the VOP with 10.0.0.1 as the connection IP address (that is the address set in 
the tape drive when Sun shipped it). 

5. Perform the following procedure for each tape until all tape drives have the proper 
IP address set. 

a. Connect the tape drive into the switch with the appropriately numbered Ethernet 
cable - this is where you plug the Ethernet cable into the tape drive’s Ethernet 
port. 

b. After the VOP connects to the tape drive, do the following:

i. If the T10000 tape drive is not set to Offline (the Online button is grey when it 
is Offline and blue when it is Online), from the main menu, click Drive 
Operations > Set Offline to set it to Offline. 

ii. Go to the tape drive’s network connections setting by clicking Configure > 
Drive Data > Network. 

iii. Click in the IP Address fill-in area and enter the IP address. 

iv. Do the same thing for subnet mask, gateway, and node name. 

v. Click Commit at the bottom of the dialogue box. This saves the settings and 
will IPL the tape drive. 

c. Go to next drive by going back to Step a. 

Note – The VOP does not have to be restarted. It is still looking to connect to a tape 
drive with the IP address of 10.0.0.1, which the next unconfigured tape drive will have. 

6. UNIX and Solaris: Run the script multiVOP. A tag was put in the .netrc file for 
each T10000 tape drive identified to the make netrc utility. MultiVOP will launch a 
window for each T10000 tape drive in the .netrc file. 

Note – If you add entries to the .netrc file manually, the multiVOP script will NOT 
launch a sunVOP for that drive. 
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FIGURE B-1 Basic Non-SDP VOP Connection Diagram

Figure Reference Description

1 Host computer on which the VOP is installed 

2 Ethernet switch box (see manufacture’s documentation for operation, settings, connections, and 
other requirements) 

3 T10000 tape drive
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APPENDIX

 

C

Service Calls

If you have as much of the following information as possible when you place a service 
call, the process is much easier: 

■ Account name

■ Site location number

■ Contact name

■ Telephone number

■ Equipment model number

■ Tape drive address

■ Tape drive code level

■ Tape drive serial number

■ Urgency of the problem

■ Fault Symptom Code (FSC) from either the tape drive’s front panel display screen 
(rack mount drives), the VOP display screen, or as is displayed on the host system 
display screen

■ Problem description

■ What color and flash rate is exhibited by LED on the rear of the tape drive? (This 
LED is not visible when the tape drive is installed in some libraries.)

■ Is the tape drive in a library? If so, which library?

■ If the tape drive was running properly before this incident:

■ What changes has the site made recently?

■ What software application was running at the time of the failure?

■ Were any hardware configuration changes made recently?

■ Were any software configuration or upgrades done recently?

■ Were any additions or deletions to the hardware or software done at the site? 

■ If the tape drive was NOT running properly before this incident, what was the last 
problem?
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Glossary

This glossary defines terms and abbreviations in this publication. 

Some of the definitions are taken from other glossaries. The letters in the parentheses 
that follow some definitions indicate the source of the definition:

(A) The American National Standard Dictionary for Information Systems, ANSI X3.172-1990, 
copyright 1990 by the American National Standards Institute (ANSI).

(E) The ANSI/Electronic Industries Association (EIA) Standard-440-A, Fiber Optic 
Terminology.

(I) The Information Technology Vocabulary, developed by Subcommittee 1, Joint Technical 
Committee 1, of the International Organization for Standardization and International 
Electrotechnical Commission (ISO/IEC/JTC1/SC1).

(IBM) The IBM Dictionary of Computing, copyright 1994 by IBM.

(T) Draft international standards committee drafts, and working papers being 
developed by the ISO/IEC/JTC1/SC1.

A
address A character or group of characters that identifies a register, a particular part of 

storage, or some other data source or destination. (A). 

C
capacity Total amount of User Data stored on one data cartridge in 8 bit bytes. 

Synonymous with “User Capacity” or “Native Capacity”. This is the capacity that 
the user sees after the ECC/Format/ERP etc. overhead has been assessed (no 
compression). 

capacity, raw Total amount of data stored on one data cartridge in 8 bit bytes before any 
ECC/Format/ERP etc. overhead has been assessed (no compression). 

capacity, user Total amount of data stored on one data cartridge in 8 bit bytes that is sent by 
the host computer. This is the capacity that the user sees after the 
ECC/Format/ERP etc. overhead has been assessed (no compression). 
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cartridge A storage device that consists of magnetic tape on supply and takeup reels, in a 
protective housing. (IBM)

cleaning cartridge A data cartridge that contains special material to clean the tape path in a 
transport or drive. 

compress To save space by eliminating gaps, empty fields, redundancy, or unnecessary 
data to shorten the length of records or files. (IBM)

configuration The manner in which the hardware and software of an information processing 
system is organized and interconnected. (T)

connector An electrical or optical part that joins two or more other parts.

D
data cartridge A container holding magnetic tape that can be processed without separating the 

tape from the container. 

data security erase (DSE) A random binary pattern, over-writing existing data, from the point of an Erase 
command, to the end-of-tape.

data tape A data cartridge formatted for use as a regular data tape for the system in which 
it is used. 

data track(s) The region(s) of recorded tape containing user data formed as discreet 
longitudinal “tracks” (similar to railroad tracks). 

diagnostics Pertaining to the detection and isolation of errors in programs and faults in 
equipment. (IBM)

drive A device for moving magnetic tape and controlling its movement. (IBM)

dump To copy the contents of all or part of virtual storage to collect error information. 
(IBM)

E
emulation The use of programming techniques and special machine features to permit a 

computing system to execute programs written for another system. (IBM)

EOT End of Tape. 

error A discrepancy between a computed, observed, or measured value or condition 
and the true, specified, or theoretically correct value or condition. (I) (A)

ESD Electrostatic Discharge. 
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F
fault symptom code 

(FSC) A four-character hexadecimal code generated in response to an error to help 
isolate failures within the device. 

FC See fibre channel.

fiber optics The branch of optical technology concerned with the transmission of radiant 
power through fibers made of transparent materials such as glass, fused silica, 
and plastic. (E)

fiber-optic cable A cable made of ultrathin glass or silica fibers which can transmit data using 
pulses of laser light. Fiber-optic cables have several advantages over copper 
cables: they have much less signal loss; they allow information to be transmitted 
at higher speeds and over longer distances; they are not affected by external 
electrical noise; and they are better for transmissions which require security.

fibre channel The National Committee for Information Technology Standards standard that 
defines an ultrahigh-speed, content-independent, multilevel data transmission 
interface that supports multiple protocols simultaneously. Fibre Channel 
supports connectivity to millions of devices over copper and/or fiber-optic 
physical media and provides the best characteristics of both networks and 
channels over diverse topologies.

fibre connection 
(FICON) An ESA/390 and zSeries computer peripheral interface. The I/O interface uses 

ESA/390 and zSeries FICON protocols (FC-FS and FC-SB-2) over a Fibre 
Channel serial interface that configures units attached to a FICON-supported 
Fibre Channel communications fabric.

FICON See fibre connection (FICON). 

FICON channel A channel having a Fibre Channel connection (FICON) channel-to-control-unit 
I/O interface that uses optical cables as a transmission medium. 

file-protect To prevent the erasure or overwriting of data stored on data cartridges.

FIPS Federal Information Processing Standards

FRU Field Replaceable Unit. 

FSC Fault Symptom Code. 

FTP Generic definition: File Transfer Protocol. 

G
GB See gigabyte (GB).

Gb Gigabit, equal to 109 bits.

Gbps Gigabits per second.

gigabyte (GB) One billion (109) bytes. 
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H
hardware All or part of the physical components of an information processing system, 

such as computers or peripheral devices. (T) (A)

hub A Fibre Channel Arbitrated Loop switching device that allows multiple servers 
and targets, such as storage systems, to connect at a central point. A single hub 
configuration appears as a single loop.

I
indicator A device that provides a visual or other indication of the existence of a defined 

state. (T)

interface Hardware, software, or both, that links systems, programs, or devices. (IBM)

internet protocol (IP) A protocol used to route data from its source to its destination in an Internet 
environment. (IBM)

internet protocol (IP) 
address A four-byte value that identifies a device and makes it accessible through a 

network. The format of an IP address is a 32-bit numeric address written as four 
numbers separated by periods. Each number can be from 0 to 255. For example, 
129.80.145.23 could be an IP address.

IP See internet protocol (IP)

L
library A robotic system that stores, moves, mounts, and dismounts data cartridges that 

are used in data read or write operations.

link A physical connection (electrical or optical) between two nodes of a network.

M
menu A list of options displayed to the user by a data processing system, from which 

the user can select an action to be initiated. (T)
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N
network An arrangement of nodes and branches that connects data processing devices to 

one another through software and hardware links to facilitate information 
interchange.

O
offline Neither controlled by, nor communicating with, a computer. (IBM)

online Pertaining to the operation of a functional unit when under the direct control of 
the computer. (T)

P
performance One of two major factors, together with facility, on which the total productivity 

of a system depends. Performance is largely determined by a combination of 
throughput, response time, and availability. (IBM)

R
read/write head The data sensing and recording unit of a diskette magazine drive or tape drive. 

(IBM)

release A distribution of a new product or new function and fixes for an existing 
product. (IBM)

R/W Read/Write.

S
SCSI Small Computer Serial Interface. 

SDP Service Delivery Platform. 

submenu A menu related to and reached from a main menu. (IBM)

sub-system A system that is part of some larger system. 

switch In Fibre Channel technology, a device that connects Fibre Channel devices 
together in a fabric.
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system A combination of functionally interrelated interacting mechanical and electrical 
elements designed to work as a coherent entity. 

T
tape drive A device for moving magnetic tape and controlling its movement. (T)

TCP/IP Transmission Control Protocol/Internet Protocol

transmission control 
protocol/internet protocol 

(TCP/IP) A set of communication protocols that support peer-to-peer connectivity 
functions for both local and wide area networks. (IBM)

V
Virtual Operator Panel

(VOP) A software application that allows a user to monitor and perform some 
operations on a large number of tape drives remotely.

VOLSER VOLume SERial Number. It is, usually 6 characters long and is both the paper 
label stuck on the back edge of the cartridge and in the VOLID label that is 
recorded, particularly by MVS systems, at the beginning of the media. 

volume serial number 
(VOLSER) An alphanumeric label that the host software uses to identify a volume. It 

attaches to the spine of a cartridge and is both human- and machine-readable.

VOP See Virtual Operator Panel (VOP).

W
wrap A single pass of tape from either BOT to EOT or EOT to BOT with the head(s) in 

a fixed transverse location. 

write-enabled A setting on a data cartridge that allows data to be written on the tape.

write-protected A setting on data cartridges that prevents data from being written on the tape. 
Reading data is still possible.
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